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Abstract 

Performance tuning and optimization is a continuous balancing act between design decisions and 

resource availability. This white paper provides tips, tricks, and guidance for optimizing and 

maintaining the performance of Microsoft Dynamics CRM clients connecting to Microsoft 

Dynamics CRM 2011 or Microsoft Dynamics CRM Online. 
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Performance tuning and optimization is a continuous balancing act between design decisions and 

resource availability. This white paper provides tips, tricks, and guidance for optimizing and 

maintaining the performance of Microsoft Dynamics CRM clients connecting to Microsoft 

Dynamics CRM 2011 or Microsoft Dynamics CRM Online. 

Applies To 
 Microsoft Dynamics CRM 2011 

 Microsoft Dynamics CRM Online 

 

In this White Paper 

Introduction 

Overview of optimizing and maintaining Microsoft Dynamics CRM clients 

General approach to optimization and maintenance 

Factors affecting the performance of Microsoft Dynamics CRM clients 

Configuring Microsoft Dynamics CRM clients for optimal performance 

Customizing Microsoft Dynamics CRM for optimal client performance 

Appendix A: Additional resources 

Appendix B: Accessibility for Microsoft Dynamics CRM 

Appendix C: Microsoft Dynamics CRM web application recommendations for a rich experience 

with forms 

Appendix D: Microsoft Dynamics CRM Online performance troubleshooting 

Feedback 

This section introduces the purpose, scope, and applicability of the information provided in this 

paper. 

Purpose 

This white paper is designed to complement, rather than replace, existing support resources that 

are available for Microsoft Office Outlook and Microsoft Internet Explorer. To that end, contents 
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include techniques and best practices that are specific to optimizing and maintaining the 

performance of Microsoft Dynamics CRM clients interacting with a solution based on Microsoft 

Dynamics CRM 2011 or Microsoft Dynamics CRM Online, together with links to related resources 

for additional information as appropriate. 

Scope 

This paper focuses on client-side optimization and maintenance. For customers working with on-

premises or hosted deployments of Microsoft Dynamics CRM 2011, be sure to consider server-

side optimizations that can have a significant impact on the client-side performance. For 

information about server-side optimization and maintenance, see the white paper Optimizing and 

maintaining a Microsoft Dynamics CRM 2011 server infrastructure. 

Applicability 

When considering the applicability of the information in this white paper to any specific solution 

based on Microsoft Dynamics CRM 2011 or Microsoft Dynamics CRM Online, note that the 

techniques and guidance provided in this white paper can yield varying results depending on a 

wide range of potential environmental factors, for example the level and complexity of the 

customizations applied to a Microsoft Dynamics CRM solution. 

As a result, be sure to verify the functionality and performance impact associated with any 

specific optimization technique in a test environment prior to making any change in a production 

environment. 

For clients connected to a Microsoft Dynamics CRM solution that is integrated with other 

systems, be sure to verify optimization techniques in a test environment that 

approximates the complexity and integration that is present in the production 

environment. 

Download 

This paper can be downloaded from the Microsoft Download Center: Optimizing and maintaining 

client performance for Microsoft Dynamics CRM 2011 and CRM Online. 

Overview of optimizing and maintaining Microsoft 
Dynamics CRM clients 
Access to and interaction with a business solution based on Microsoft Dynamics CRM 2011 or 

Microsoft Dynamics CRM Online is available by using the following Microsoft Dynamics CRM 

client offerings: 

 The Microsoft Dynamics CRM Web client, which leverages Windows Internet Explorer as a 

browser to provide access to Microsoft Dynamics CRM functionality without requiring the 

installation of client software on a user's computer. 

 Microsoft Dynamics CRM for Microsoft Office Outlook, which provides a Windows-based user 

experience that is highly integrated with Microsoft Office Outlook. Microsoft Dynamics CRM 

for Microsoft Office Outlook with Offline Access is a second configuration of the client that 

Important  

http://go.microsoft.com/fwlink/?LinkID=213093
http://go.microsoft.com/fwlink/?LinkID=213093
http://go.microsoft.com/fwlink/?LinkID=214217
http://go.microsoft.com/fwlink/?LinkID=214217
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provides users with the additional capability to synchronize Microsoft Dynamics CRM data for 

offline availability. 

Users can also connect to an implementation of Microsoft Dynamics CRM from an 

Internet-enabled mobile device, such as a cell phone, by using the Mobile Express client, 

which provides access via a lightweight version of the Microsoft Dynamics CRM Web 

client. 

Successfully optimizing and maintaining the performance of Microsoft Dynamics CRM clients 

connecting to a business solution based on Microsoft Dynamics CRM 2011 or Microsoft 

Dynamics CRM Online requires: 

Familiarity with: 

 A general approach to optimization and maintenance 

 Factors that can adversely affect the performance of Microsoft Dynamics CRM clients 

A solid understanding of: 

 Options available for configuring Microsoft Dynamics CRM Online clients to overcome 

potential performance issues 

 Best practices for customizing Microsoft Dynamics CRM Online clients for optimal 

performance 

The white paper is designed to address these topics, providing readers with the information 

necessary to optimize and maintain the performance of Microsoft Dynamics CRM Online clients. 

The performance of Microsoft Dynamics CRM Online clients can be assessed in a variety 

of ways. However, performance levels are often reflected by the amount of time it takes 

for the client to load and display pages and forms. 

Load times are commonly categorized as either “cold” (on the first visit to a page during a 

session) or “warm” (on subsequent visits to the same page during the same session). 

During a cold page load, a number of round trips between the client and the server are 

required to collect and display the appropriate information to the end user. On 

subsequent visits to the same page, the client requires many fewer round trips to display 

the page, as much of the required page information has been cached locally during the 

initial page visit. 

General approach to optimization and 
maintenance 
Performance tuning and optimization is a continuous balancing act between design decisions and 

resource availability. Consider taking the following high-level approach when optimizing and 

maintaining the clients that access a connected system such as Microsoft Dynamics CRM. 

Note  

Important  

Note  
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Because Microsoft Dynamics CRM clients are CPU and memory intensive, the level of 

the hardware on which a client is running directly affects the performance of that client, 

with better hardware configurations yielding better performance results. 

Regularly downloading and installing the latest hotfixes and update rollups is a key first 

step in efforts to enhance and maintain the performance of clients that are accessing a 

Microsoft Dynamics CRM implementation. For a listing of current resources, updates, and 

hotfixes available for Microsoft Dynamics CRM Online or Microsoft Dynamics CRM 2011, 

see the Support for Dynamics CRM page. 

Optimizing Performance and Establishing a Baseline 

After setting up a Microsoft Dynamics CRM solution, it is important to assess the overall 

performance of the clients that will be accessing the solution within the context of the unique 

business and environmental factors inherent in a specific scenario. The results of this analysis 

can serve as an initial baseline against which to measure the impact of efforts to optimize client 

performance for a specific environment. 

After ensuring that the clients accessing the Microsoft Dynamics CRM solution are performing at 

optimal levels, be sure to capture a second set of results to serve as a baseline for future 

monitoring and of the optimized levels of performance. 

Monitoring and Maintaining Performance 

To maintain the optimal performance of Microsoft Dynamics CRM clients over time, it is important 

periodically to monitor performance levels by leveraging the functionality of the Windows 

Performance Monitor or the Windows Resource Monitor. 

These system tools provide information about the use of hardware and software resources in real 

time, and results can be filtered to monitor specific processes or services. In addition, they can be 

used to start, stop, suspend, and resume processes and services, and to troubleshoot when an 

application does not respond as expected. 

For additional information about Performance Monitor, Resource Monitor, and general 

guidelines and best practices for monitoring performance, see the following resources: 

 Performance Monitoring Getting Started Guide. 

 Resource Availability Troubleshooting Getting Started Guide. 

 Windows Vista Performance and Reliability Monitoring Step-by-Step Guide 

 

For the latest information about Microsoft Dynamics CRM performance in general and to 

learn about the release of additional support resources, see the Microsoft Dynamics CRM 

Team blog. 

Important  

Note  

http://support.microsoft.com/ph/629
http://technet.microsoft.com/en-us/library/dd744567(WS.10).aspx
http://technet.microsoft.com/en-us/library/dd883276(WS.10).aspx
http://technet.microsoft.com/en-us/library/cc722173(WS.10).aspx
http://blogs.msdn.com/crm/
http://blogs.msdn.com/crm/
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Factors affecting the performance of Microsoft 
Dynamics CRM clients 
The performance Microsoft Dynamics CRM clients can be directly affected by a wide variety of 

factors, including: 

 The hardware level of the computer running the client and the versions of software that are 

installed, as well as the configuration of selected Control Panel settings 

 Any extraneous processes and applications running on the same computer 

 The characteristics of the network over which client access occurs 

 The level and complexity of customizations applied to the solution 

In addition, Microsoft Dynamics CRM for Outlook performance can potentially be affected by: 

 The number of Microsoft Dynamics CRM organizations that a single instance of Microsoft 

Dynamics CRM for Outlook is configured to access. By default, Microsoft Dynamics CRM for 

Outlook is configured to access and display information from a single “primary” Microsoft 

Dynamics CRM organization, but it can be configured to display information from one or more 

secondary organizations. However, increasing the number of organizations that a single 

instance of Microsoft Dynamics CRM for Outlook is configured to access also increases client 

memory requirements. 

 The volume of data that is processed during: 

 Outlook synchronization 

 Offline synchronization (Microsoft Dynamics CRM for Outlook with Offline Access only) 

Hardware and software requirements 

Key factors in the overall performance of computers running Microsoft Dynamics CRM clients 

include the level of hardware, versions of software, and Power Settings configuration associated 

with a particular computer. 

Hardware levels and software versions 

The performance of a Microsoft Dynamics CRM client is directly affected by the hardware on 

which that client is running, with higher-level hardware configurations (especially the level of 

processor and amount of memory) typically yielding better performance. In addition, there are 

specific software requirements associated with running Microsoft Dynamics CRM clients. As a 

result, be sure to verify that computers running Microsoft Dynamics CRM clients meet the 

appropriate hardware and software requirements according to their usage. 

For a listing of the hardware and software requirements for running Microsoft 

Dynamics CRM clients, in the Implementation Guide, in the Planning Guide, see the 

following topics: 

 Microsoft Dynamics CRM for Outlook hardware requirements. 

 Microsoft Dynamics CRM for Outlook software requirements. 

Note  

http://technet.microsoft.com/en-us/library/hh699680.aspx
http://technet.microsoft.com/en-us/library/hh699818.aspx
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 Microsoft Dynamics CRM Web client software requirements. 

Later versions of Internet Explorer provide enhancements that improve page rendering. It 

is recommended that computers running Microsoft Dynamics CRM clients be installed 

with the latest version of Internet Explorer supported within a specific business 

environment. For an optimal experience with Microsoft Dynamics CRM Online, use 

Internet Explorer 9, if possible. Internet Explorer 9 includes JavaScript acceleration 

functionality to help improve client-side performance. 

Power settings 

In addition to hardware and software requirements, selected Control Panel settings can also 

affect performance. Windows provides a variety of power plans settings to help users manage 

their computers’ power consumption and performance. 

 Balanced. Offers full performance when you need it and saves power during periods of 

inactivity. This is the best power plan for most people. 

 Power saver. Saves power by reducing system performance and screen brightness. This 

plan can help laptop users get the most from a single battery charge. 

 High performance. Maximizes screen brightness and might increase the computer's 

performance in some circumstances. This plan uses a lot more energy and will reduce the 

amount of time that a laptop battery lasts between charges.  

High performance does not appear on the battery meter by default. To turn on High 

performance, in Control Panel, open the Power Options item, under Select a power 

plan, click Show additional plans, and then click High performance. 

Microsoft Dynamics CRM performs best when a computer’s power plan is set to “High 

Performance,” which is the recommended setting to ensure the fastest performing computer for 

running Microsoft Dynamics CRM for Outlook and Microsoft Dynamics CRM for Outlook with 

Offline Access, and the Microsoft Dynamics CRM Web client. 

Extraneous processes and applications 

All the processes and applications running on a client computer can adversely affect the 

performance of Microsoft Dynamics CRM clients. 

Non-critical business processes and non-essential applications 

For client computers with hardware at or near minimal-level requirements, consider turning off 

non-critical business processes, video streaming, and software such as games and music 

programs, to accelerate performance. Because this issue can have a greater impact on client 

computers configured for offline access, third-party add-ins for Microsoft Office Outlook can also 

be disabled to improve the performance of Microsoft Dynamics CRM for Outlook. 

Important  

Note  

http://technet.microsoft.com/en-us/library/hh699710.aspx
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Security packages and virus scanning applications 

Microsoft Dynamics CRM client performance can also be affected by desktop security software, 

including malware applications and antivirus programs, which can lock certain files and make 

them inaccessible to other applications. In addition, some of these software packages include a 

feature called ScriptScan, which scans all web pages for malicious script and is known to affect 

the performance of web-based applications such as Microsoft Dynamics CRM. 

Most of these programs provide the ability to disable scanning on specific web sites, and if so, 

adding the URL of the Microsoft Dynamics CRM organization to a list of excluded sites can help 

to improve performance in these situations. 

To exclude sites from scanning in McAfee specifically, see the following KB articles: 

 ScriptScan improvement to whitelist URLs for trusted web sites (Performance improvement 

for web-based applications that are script intensive). 

  Slow performance with McAfee antivirus. 

 

For additional detail about disabling scanning in other antivirus applications, see the 

documentation associated with the specific application. 

Each environment requires a thoughtful decision on what to include and exclude, and 

there is always a possibility that excluding files from scans can lead to unwanted 

consequences. Be sure to consider these options together with the well planned internal 

IT management policies established for a specific scenario. 

Network characteristics 

The primary characteristics of a network that affect the performance of Microsoft Dynamics CRM 

clients are bandwidth and latency. 

 Bandwidth is the width or capacity of a specific communications channel. 

 Latency is the time required for a signal to travel from one point on a network to another; 

latency is a fixed cost between two points. 

One of the main causes of poor performance of Microsoft Dynamics CRM clients is the latency of 

the network over which the clients connect to the Microsoft Dynamics CRM solution. Lower 

latencies (measured in milliseconds) generally provide better levels of performance. 

Note that even if the latency of a network connection is low, however, bandwidth can become a 

factor if there are a lot of resources sharing the network connection, for example to download files 

and send and receive email. 

Networks with high bandwidth do not guarantee low latency. For example, a network path 

traversing a satellite link often has high latency, even though throughput is very high. It is not 

uncommon for a network round trip traversing a satellite link to have five or more seconds of 

latency. An application designed to send a request, wait for a reply, send another request, wait for 

Important  

Important  

https://kc.mcafee.com/corporate/index?page=content&id=KB65382
https://kc.mcafee.com/corporate/index?page=content&id=KB65382
http://support.microsoft.com/kb/924341
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another reply, and so on, will wait at least five seconds for each packet exchange, regardless of 

the speed of the server. 

It is recommended to test the implications of client performance in any WAN environment 

with potential bandwidth or latency issues, which can vary greatly from performance in a 

LAN environment. 

For example, users connecting to a standard configuration of Microsoft Dynamics CRM 

2011 in a LAN environment (up to 10ms latency) can expect Account or Contact forms to 

load within 2 to 2.5 seconds, while users connecting to a similar configuration of Microsoft 

Dynamics CRM 2011 or Microsoft Dynamics CRM Online in a WAN environment (up to 

150ms latency) can expect 3 to 3.5 second load times for the same forms. Note that 

Microsoft Dynamics CRM Online users always work over connections with characteristics 

that more closely resemble a WAN environment than a LAN environment. 

Microsoft Dynamics CRM is designed to work best over networks with latency under 150 

ms (milliseconds) and bandwidth greater than 50 kbps (kilobytes per second). 

Level and complexity of customizations 

When optimizing the performance of Microsoft Dynamics CRM clients, keep in mind that client 

performance is directly affected by the: 

 Number of: 

 Columns and grids in use 

 Rows returned per page 

 Sub-grids used on a page 

 Controls on a form (Form Design) 

 Controls on the ribbon 

 Client-side events (OnLoad, OnSave, OnChange) 

 Complexity and number of visualizations used in dashboards 

 Use of Jscript and Plugins. Advanced Jscript can add a significant amount of time to, open, 

save, close and other events especially if calls are made to Microsoft Dynamics CRM or other 

system. Plug-ins can also affect performance when saving. 

As a result, in environments with high latency and/or low bandwidth, it is recommended to limit 

use of these features and functionalities as much as possible without compromising business 

requirements. In addition, for any customization features that are required in your business 

environment be sure to limit the number of times that you publish customizations, as this process 

can also negatively impact client performance. 

Warning  
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Configuring Microsoft Dynamics CRM clients for 
optimal performance 
To help overcome latency and maximize bandwidth usage for the best performance of Microsoft 

Dynamics CRM clients, consider the following techniques. 

Configuring Internet Explorer for optimal performance 

There are several configuration techniques available for optimizing the performance of Windows 

Internet Explorer, which are detailed in the following sections. 

Configuring client-side browser settings 

Internet Explorer 7 and later versions are by default configured to automatically manage client-

side browser settings, which can greatly affect user experience over slower connections. 

To help optimize performance, however, it may at times be advisable to increase the amount of 

hard disk space that is reserved for temporary Internet files. This technique ensures that the 

cache has adequate space to take advantage of improved load times when making subsequent 

visits to the same page for the same files. 

To increase the disk space size for temporary Internet files 

1. In Internet Explorer, on the Tools menu, click Internet options. 

2. In the Internet Options dialog box, on the General tab, under Browsing history, and then 

click Settings. 

3. In the Temporary Internet Files and History Settings dialog box, under Check for newer 

versions of stored pages, verify that Automatically is selected. 

4. In the Disk space to use box, specify a value from 50 to 250 megabytes (the closer to 250 

MB, the better) of disk space for temporary Internet files, and then click OK. 

5. In the Internet Options dialog box, on the General tab, under Browsing history, verify that 

the Delete browsing history on exit check box is cleared to prevent deletion of temporary 

Internet files each time that the browser is closed. 

6. On the Advanced tab, under Settings, scroll down to Security settings and verify that the 

Do not save encrypted pages to disk check box is cleared, and then click OK. 

After the client-side browser settings on a computer are modified, loading the Microsoft 

Dynamics CRM Web client for the first time (the “cold” load) may take several moments 

longer than usual. However, subsequent page loads (“warm” loads) will show improved 

performance as many of the Microsoft Dynamics CRM web pages will have been cached 

during the initial load. 

Configuring simultaneous download sessions 

In Windows Internet Explorer 7 and earlier versions, users are by default limited to two 

simultaneous downloads. In Windows Internet Explorer 8, however, the default limit is increased 

Note  
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to six, a change that reflects the faster connection speeds that are now typical for most users. 

Note that for dial-up connections, the limits from earlier versions still apply. 

The Microsoft Dynamics CRM Online application synchronously requests data to and from the 

Microsoft Dynamics CRM Online data center, which in many cases can easily exhaust the 

available number of simultaneous downloads. 

The following procedures require modification of the registry, which can create serious 

problems if the registry is modified incorrectly. As a result, be sure to follow these steps 

carefully and for added protection, back up the registry before making any changes. 

 

Internet Explorer 7: 

To increase the number of files that can be downloaded at one time to 10 

1. Start Registry Editor, and then navigate to the following key:  

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Internet Settings 

2. On the Edit menu, point to New, click DWORD Value, and then add the following registry 

values: 

 Value name: MaxConnectionsPer1_0Server 

 Value data: 10 

 Base: Decimal 

 Value Name: MaxConnectionsPerServer 

 Value data: 10 

 Base: Decimal 

3. Exit Registry Editor. 

 

Internet Explorer 8 and later versions: 

To configure the connection limit by modifying a registry key 

1. Start Registry Editor, and then navigate to the following key:  

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet 

Explorer\MAIN\FeatureControl\FEATURE_MAXCONNECTIONSPERSERVER 

2. On the Edit menu, point to New, click DWORD Value, and then add the following registry 

value: 

 Value name: iexplore.exe 

 Value data: 10 

 Base: Decimal 

Set this value to the connection limit that you want for HTTP 1.1 connections. By 

setting the value to 10, you increase the connection limit to 10. 

3. Exit Registry Editor. 

Important  

Note  
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To configure the connection limit by using Group Policy 

1. Click Start, click Run, type gpedit.msc, and then click OK. 

2. In Local Group Policy Editor, under Local Group Policy, under User Configuration, 

navigate to:  

Administrative Templates\Windows Components\Internet Explorer\Security 

Features\AJAX 

3. Specify the appropriate values for the Maximum number of connections per server (HTTP 

1.0) and Maximum number of connections per server (HTTP 1.1) settings, and then close 

Local Group Policy Editor. 

4. Update policies or restart the computer to apply the modified configuration. 

Configuring the Internet Explorer Zoom setting 

The Zoom functionality in Internet Explorer lets you enlarge or reduce the view of a web page. 

Unlike changing font size, zoom enlarges or reduces everything on the page, including text and 

images. You can zoom from 10% to 1000%. 

Note however that a Zoom setting of anything other than “100%” will result in an increase in page 

rendering time, and hence in slower performance from your Microsoft Dynamics CRM system. 

To configure the Internet Explorer Zoom setting to 100% 

Do one of the following: 

 Press Ctrl+0, which is the keyboard short-cut for a 100% zoom level setting in most versions 

of Internet Explorer. 

 In Internet Explorer 7, on the menu bar, click Page, point to Zoom, and then click 100%. 

 In Internet Explorer 8 and later versions, on the menu bar, click View, point to Zoom, and 

then click 100%. 

Configuring Microsoft Dynamics CRM for Outlook for optimal 
performance 

There are several configuration techniques available for optimizing the performance of Microsoft 

Dynamics CRM for Outlook, which are detailed in the following sections. 

Over very high latency connections, often a Terminal Services/Citrix connection will 

improve performance. Note that Terminal Services/Citrix connections are only accessible 

via Microsoft Dynamics CRM for Outlook; Terminal Services does not support Microsoft 

Dynamics CRM for Outlook with Offline Access. 

Optimizing the Outlook synchronization process 

To optimize the performance of Microsoft Dynamics CRM for Outlook, configure the filters 

associated with the Outlook synchronization process to affect the fewest record types and to 

occur as infrequently as possible without compromising business requirements and to avoid 

creating duplicate records if key fields match. 

Note  
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To configure the filters associated with the Outlook synchronization process 

1. In Outlook 2003 or Outlook 2007, on the CRM menu, click Options. 

- OR - 

In Outlook 2010, on the File tab, click CRM, click Options. 

2. In the Set Personal Options dialog box, on the Synchronization tab, under Synchronize 

Microsoft Dynamics CRM items with my default Outlook folders, click Outlook Filters. 

3. In the Filter: Outlook dialog box, on the User Filters tab, click the name of the filter that you 

want to edit, or on the Actions toolbar, click New to create a new filter, and then edit the filter 

as necessary. 

You can also use the Filter: Outlook dialog box to specify the status of an existing 

Outlook filter as either Active or Inactive. 

4. Click OK to save any changes and close the Filter: Outlook dialog box. 

5. To define the frequency with which the Microsoft Dynamics CRM  items in your Microsoft 

Dynamics CRM for Outlook folders are updated in the background, in the Set Personal 

Options dialog box, select the Synchronize the CRM items in my Outlook folders every 

check box, and then specify the number of minutes between each update. 

Using this feature provides the user with the convenience of not having to remember to 

manually synchronize Microsoft Dynamics CRM with Outlook. 

An organization must permit a user to change the Synchronize the CRM items in 

my Outlook folders every check box, and the administrator sets the minimum time 

allowed between synchronizations. 

6. Click OK to save any changes and close the Set Personal Options dialog box. 

For more information about Outlook synchronization, see the white paper Outlook 

Synchronization in Microsoft Dynamics CRM*  

* Microsoft Dynamics CRM 4.0 version prior to update for Microsoft Dynamics CRM 2011 

Tuning background polling activity 

Microsoft Dynamics CRM for Outlook has background polling activities that communicate to the 

server and react to server-side changes regardless of client-side activity, and the level of 

background activity associated with regular polling can impact overall client performance. 

Microsoft Dynamics CRM includes caches for features such as the Address Book, reminders, and 

views, and the default polling interval for MAPI caches is 15 minutes. To tune the polling intervals 

for various MAPI caches, you can modify one or more of a set of registry keys. 

For additional information, including a list of the client-side registry keys that influence the level of 

background activity associated with Microsoft Dynamics CRM for Outlook, see Knowledge Base 

Warning  

Warning  

Warning  

http://go.microsoft.com/fwlink/?LinkID=215726
http://go.microsoft.com/fwlink/?LinkID=215726
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Article 282157, Slow performance when using the Microsoft Dynamics CRM 2011 Client for 

Outlook. 

Optimizing Address Book performance 

To optimize Address Book performance, configure the Address Book to match only against the 

contacts that are synchronized to Microsoft Dynamics CRM and to retrieve updates as 

infrequently as possible without compromising business requirements. 

To set Address Book options for optimal performance 

1. In Outlook 2003 or Outlook 2007, on the CRM menu, click Options. 

- OR - 

In Outlook 2010, on the File tab, click CRM, and then click Options. 

2. In the Set Personal Options dialog box, on the Address Book tab, under Select how email 

recipients are reconciled with Microsoft Dynamics CRM records: 

 For Contacts, choose whether names and email addresses from the address book are 

compared to some or all of your Microsoft Dynamics CRM contacts. 

i. Match only against contacts synchronized to Microsoft Dynamics CRM 

specifies to link email messages to the Microsoft Dynamics CRM contact records that 

you have chosen to synchronize and also match a name or email address in your 

address book. This option is selected by default. 

ii. Match all contacts in Microsoft Dynamics CRM specifies to link email messages 

to any Microsoft Dynamics CRM contact record that also matches a name or email 

address in the address book. 

 For Other record types, choose whether you want to link email messages to other record 

types if the names and email addresses in the other record types match those in the 

address book; also choose the types of records. 

i. Do not match specifies not to link email messages to other record types 

ii. Match only the items I own specifies to link email messages to other records types. 

This option is selected by default. 

iii. Match all items in Microsoft Dynamics CRM specifies to link email messages to all 

record types in Microsoft Dynamics CRM. 

3. Under Select how often the Outlook Address Book should be updated from Microsoft 

Dynamics CRM, select the Update the Outlook Address Book every check box, and then 

in the box to the left of hours, type in the number of hours you want between each Address 

Book update. 

4. Click OK to save the changes and close the Set Personal Options box dialog box. 

Pinning commonly used views 

With Microsoft Dynamics CRM for Outlook, users can open tabs to display multiple views of an 

entity. Users can also “pin” views so they always display when a user logs in to Outlook. Pinned 

views, which are stored in cache, respond more quickly than do standard views, so be sure that 

suggest that users “pin” the views with which they most commonly interact. 

http://support.microsoft.com/kb/2585157
http://support.microsoft.com/kb/2585157
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Each pinned view consumes system resources (memory), so be sure to balance the use 

of pinned views against the broader requirements for system resources. 

To pin a view in Microsoft Dynamics CRM for Outlook 

1. In Outlook, click the tab to the right of the active tab, and then select the view to pin. 

2. On the tab, click the push pin symbol (the symbol will turn vertically). The view is now pinned, 

so that the next time the user logs on, the pinned view will display rather than the default 

view. 

Optimizing the offline synchronization process 

To optimize the offline synchronization process on computers running Microsoft Dynamics CRM 

for Outlook with Offline Access, consider the following best practices. 

 Assign all users roles with the minimum access levels and permissions required to perform a 

job function to help ensure optimized data synchronization to the offline client. 

 Whenever possible, do not use: 

 “Parent downloaded=true” clauses. Use of this clause often results in the 

synchronization of unnecessary data, which can degrade the performance of the 

synchronization process. 

 Sliding time windows. These variables calculate results from a date range that shifts 

depending on the current date (such as, “last 60 days”), and their use can adversely 

affect performance; use variables that calculate results from a specific date forward. 

 Implement local data filtering for each offline client to ensure that users have offline access 

only to the data required to perform their job functions. After implementing local data filtering, 

be sure to remain online and synchronize the data manually. The initial synchronization will 

be slower than subsequent synchronizations because Microsoft Dynamics CRM must remove 

records. 

To set offline synchronization options for optimal performance 

a. In Outlook 2003 or Outlook 2007, on the CRM menu, click Offline Filters. 

- OR - 

In Outlook 2010, on the File tab, click CRM, click Go Offline, and then click Offline 

Filters. 

b. In the Filters: Offline dialog box, on the User Filters tab, click the name of the filter that 

you want to edit, or on the Actions toolbar, click New to create a new filter, and then edit 

the filter as necessary. 

You can also use the Filters: Offline dialog box to specify the status of an 

existing Outlook filter as either Active or Inactive. 

c. Click OK to save any changes and close the Filters: Offline dialog box. 

 Configure offline synchronization to run in the background periodically, for example every 15 

minutes, to improve performance by helping to ensure that: 

Important  

Note  
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 The user’s local database is regularly updated so that when the user actually wants to go 

offline, there’s not as much data to copy down. 

 If the user loses connection and the client goes into an offline mode, the data store is 

relatively current. 

To schedule Offline Synchronization to run in the background 

i. In Outlook 2003 or Outlook 2007, on the CRM menu, click Options. 

OR -  

ii. In Outlook 2010, on the File tab, click CRM, and then click Options. 

 In the Set Personal Options dialog box, on the Local Data tab, select the Update local 

data every check box, and then specify (in minutes) the duration of the interval between 

each synchronization attempt. The default (and minimum) value is 15 minutes. 

For more information about offline synchronization, see the following resources: 

 Offline and Online Synchronization in Microsoft Dynamics CRM*. 

* Microsoft Dynamics CRM 4.0 version prior to update for Microsoft Dynamics CRM 2011 

 Hitting the Road with Microsoft Dynamics CRM for Outlook with Offline Access. 

 Synchronizing Information (Microsoft Dynamics CRM Online-specific). 

Customizing Microsoft Dynamics CRM for optimal 
client performance 
When customizing Microsoft Dynamics CRM for optimal performance of the Microsoft 

Dynamics CRM clients, keep in mind the following best practices. 

Best practices 

 Use JScript judiciously. While a few lines of JScript can greatly enhance the user experience 

by automatically updating data as a form loads or as data changes, they can also cause a 

performance issue if a lot of JScript code is running on a form. When using JScript on forms, 

verify that code is optimized to ensure efficient form loads. 

To determine if JScript is affecting the performance of a form, remove the JScript and 

test how the form performs. Then, compare those results to the performance of the 

form with JScript included. 

 Use iFrames judiciously. The greater the number of iFrames on a form, the greater the 

associated form load time will be. If an iFrame is not on the form’s primary tab, use collapsed 

tabs and set the URL in the TabStateChange Jscript event for the tab on which the iFrame 

resides. This ensures that the iFrame loads only when a user clicks the tab, rather than 

loading each time a record is opened. 

Note  

Note  

http://go.microsoft.com/fwlink/?LinkID=215725
http://rc.crm.dynamics.com/rc/regcont/en_us/OP/articles/localdatagroup.aspx
http://rc.crm.dynamics.com/rc/regcont/en_us/op/help/ug_ol_sync.htm
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 Use sub-grids judiciously. Each sub-grid that is used in a form queries the Microsoft 

Dynamics CRM system in the background for a set of data to load into the grid. While the 

query executes in the background, each sub-grid control on a form adds more HTML to the 

page, resulting in longer load times. For sub-grids that are in use, consider having users 

collapse them, as data will not be retrieved until the user expands a sub-grid. 

Each sub-grid also includes a context-sensitive ribbon to provide users with access to 

the appropriate commands for that sub-grid. Although the ribbon only becomes 

visible when the grid is selected, the required xml (and therefore the processing) 

occurs as the form is loaded. As a result, even if a user never selects the sub-grid, 

there is a performance impact associated with each sub-grid on a form. 

 Use role-based forms to limit the fields that display on a form to accommodate the specific 

requirements of users based on their assigned security role. 

 Adjust security roles to limit the functionality presented to users based upon their specific 

requirements for selected record types. This ensures that the user interfaces adapts to 

display only the elements required by specific users to work with data in the Microsoft 

Dynamics CRM solution. 

 Consider the complexity and number of visualizations used in the dashboards on a page. 

Dashboards capture a lot of data and are loaded separately in parallel connections to the rest 

of the page. As a result, limit the number of visualizations used in a dashboard as much as 

possible without compromising business goals. 

 Use columns and grids judiciously. Optimize views and sub-grids so that only the required 

columns and grids display by default. 

 Customize forms to display only the fields required for specific types of records. 

 Limit the number of rows that are returned per page while still meeting any related business 

requirements. 

 After users are sufficiently familiar with Microsoft Dynamics CRM, hide the Get Started pane 

to reduce any impact it might have on client performance. 

The Get Started pane can be displayed or hidden by default on a per user basis or 

CRM Administrators can set this configuration for all system users. 

To set Get Started panes to display or hide for a specific user 

a. In Outlook 2003 or Outlook 2007, on the CRM menu, click Options. 

- OR -  

In Outlook 2010, on the File tab, click CRM, and then click Options. 

b. In the Set Personal Options dialog box, on the General tab, under Select the setting 

for Get Started Panes, select or deselect the Show Getting Started panes on all lists 

check box accordingly 

c. Click OK to save any changes and close the Set Personal Options dialog box. 

 

To set Get Started panes to display or hide for all users 

Important  

Note  
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a. In Outlook 2003, Outlook 2007, or Outlook 2010, on the Navigation Pane, click Settings, 

click System, click Administration, and then click System Settings. 

b. In the System Settings dialog box, on the General tab, under Select the display option 

for Get Started Panes, select or deselect the Show Getting Started panes on all lists 

for all users check box accordingly. 

c. Click OK to save any changes and close the System Settings dialog box. 

Troubleshooting considerations 

If your Microsoft Dynamics CRM environment includes customizations and your users are 

experiencing general slowness, try having users reproduce the issue in a Microsoft Dynamics 

CRM Online test environment that is not customized. This will help determine whether or not the 

issue is potentially related to customizations in the Production environment. Also consider 

disabling customizations (for example OnLoad events) in the Production environment to help 

narrow down the potential issue. 

In situations when subgrids are contributing to lengthy form load times, it may be helpful to 

collapse the subgrid sections as a test to see if performance improves.  It is possible to collapse 

sections by default on the load of the form and then expand the form shortly after. 

Appendix A: Additional resources 

Technical resources 

For more information about optimizing and maintaining Microsoft Dynamics CRM 2011, see the 

following technical resources. 

For the latest information about Microsoft Dynamics CRM performance in general and to 

learn about the release of additional support resources, see the Microsoft Dynamics CRM 

Team blog. 

 

Implementation and Installation 

 Microsoft Dynamics CRM 2011 Implementation Guide 

 Download 

 View online 

 Microsoft Dynamics CRM for Outlook Installing Guide for use with Microsoft Dynamics CRM 

Online 

 Microsoft Dynamics CRM 2011 Readme 

 

Server-Side Optimization and Maintenance 

 Optimizing and Maintaining the Performance of a Microsoft Dynamics CRM 2011 Server 

Infrastructure 

Note  

http://blogs.msdn.com/crm/
http://blogs.msdn.com/crm/
http://go.microsoft.com/fwlink/?LinkID=200050
http://technet.microsoft.com/en-us/library/hh699811.aspx
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=a4c4c297-5df5-4233-af93-9f488d63805b
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=a4c4c297-5df5-4233-af93-9f488d63805b
http://rc.crm.dynamics.com/rc/2011/en-us/on-prem/5.0/readme.htm
http://go.microsoft.com/fwlink/?LinkID=213093
http://go.microsoft.com/fwlink/?LinkID=213093
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 Performance Toolkit for Microsoft Dynamics CRM 2011 

 Bandwidth testing using Microsoft Dynamics CRM Performance Toolkit 

 Improving Microsoft Dynamics CRM Performance and Securing Data with Microsoft 

SQL Server 2008 R2 

 SAMPLE - Performance and Scalability Assessment of Customer Implementation 

 Microsoft Dynamics CRM 2011 performance counters 

 

“Nuts and Bolts” 

 Outlook Synchronization in Microsoft Dynamics CRM*  

* Microsoft Dynamics CRM 4.0 version prior to update for Microsoft Dynamics CRM 2011 

 Offline and Online Synchronization in Microsoft Dynamics CRM*  

* Microsoft Dynamics CRM 4.0 version prior to update for Microsoft Dynamics CRM 2011 

 

Development 

 Microsoft Dynamics CRM 2011 Software Development Kit 

 Microsoft Dynamics CRM Developers Center 

Microsoft Services 

Microsoft Services is the consulting and enterprise support division of Microsoft. Their mission is 

to help businesses around the world get a maximized return on their investment in Microsoft 

products and technologies. This means not only helping with deploying and optimizing IT, but 

also helping businesses move forward with IT initiatives that deliver the most business value. 

Between Enterprise Services and Customer Support Services, Microsoft Services has a global 

team of more than 9,720 professionals who work with more than 60,000 partners across 88 

countries. As a result, Microsoft Services can extend its services to take on even the largest 

projects, helping a large number of customers worldwide get the most out of existing IT assets, 

saving them money, and delivering real business results. 

Microsoft Services supports customers through a variety of services: 

 Strategy 

 Enterprise Strategy Portfolio 

 Enterprise Strategy Foundation 

 Support 

 Premier Support 

 Microsoft Services Partner Advantage 

 Contact Microsoft Services 

 Consulting 

 Business Intelligence 

 CRM Solutions 

http://go.microsoft.com/fwlink/?LinkId=213092
http://blogs.msdn.com/b/crm/archive/2010/01/22/bandwidth-testing-using-crm-performance-toolkit.aspx
http://www.microsoft.com/downloads/details.aspx?FamilyID=b5bb47a4-5ece-4a2a-a9b5-5435264f627d&DisplayLang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=b5bb47a4-5ece-4a2a-a9b5-5435264f627d&DisplayLang=en
http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=e76d8916-81a6-4330-90ae-b24f8263fff8
http://technet.microsoft.com/en-us/library/hh699694.aspx#BKMK_PerfCount
http://go.microsoft.com/fwlink/?LinkId=215726
http://go.microsoft.com/fwlink/?LinkId=215725
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=420f0f05-c226-4194-b7e1-f23ceaa83b69
http://msdn2.microsoft.com/en-us/dynamics/crm/default.aspx
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 Datacenter Services 

 Dynamic Workplace 

 Next Generation Applications 

 Optimized Desktop 

 Platform Modernization 

For more information about Microsoft Services, see the Microsoft Services web site. 

Appendix B: Accessibility for Microsoft Dynamics 
CRM 
Administrators and users who have administrative responsibilities typically use the Settings area 

of the Microsoft Dynamics CRM web application to manage Microsoft Dynamics CRM. A mouse 

and keyboard are the typical devices that administrators use to interact with the application. 

Users who don’t use a mouse can use a keyboard to navigate the user interface and complete 

actions. The ability to use the keyboard in this way is a result of support for keyboard interactions 

that a browser provides. 

For more information, see the following Microsoft Dynamics CRM web application accessibility 

topics: 

 Use Keyboard Shortcuts 

 Accessibility for People with Disabilities 

Administrators and users who have administrative responsibilities for on-premises deployments of 

Microsoft Dynamics CRM 2011 also use Microsoft Dynamics CRM Deployment Manager, a 

Microsoft Management Console (MMC) application, to manage on-premises deployments of 

Microsoft Dynamics CRM Server 2011. 

For more information, see the following Microsoft Management Console (MMC) accessibility 

topics: 

 Navigation in MMC Using the Keyboard and Mouse 

 MMC Keyboard Shortcuts 

Accessibility Features in Browsers 

 

Browser Documentation 

Internet Explorer Microsoft Accessibility 

Language Support and Accessibility Features 

Mozilla Firefox Accessibility features in Firefox 

Apple Safari Safari 

Google Chrome Accessibility Technical Documentation  

Note  

http://www.microsoft.com/microsoftservices/en/us/home.aspx
http://rc.crm.dynamics.com/rc/regcont/en_us/live/help/how_rec_keyboardshortcuts.htm
http://rc.crm.dynamics.com/rc/regcont/en_us/live/help/ug_wel_Accessibility.htm
http://technet.microsoft.com/en-us/library/cc766527.aspx
http://technet.microsoft.com/en-us/library/cc766476.aspx
http://www.microsoft.com/enable/products/ie9/default.aspx
http://technet.microsoft.com/en-us/library/gg699449.aspx
http://support.mozilla.org/en-US/kb/accessibility-features-firefox-make-firefox-and-we?redirectlocale=en-US&redirectslug=Accessibility
http://www.apple.com/safari/
https://sites.google.com/a/chromium.org/dev/developers/design-documents/accessibility
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For additional information, see the Microsoft Accessibility Resource Center 

Appendix C: Microsoft Dynamics CRM web 
application recommendations for a rich 
experience with forms 
While the Microsoft Dynamics CRM web application is designed to work on a variety of system 

configurations, ensuring a rich experience with forms in Microsoft Dynamics CRM requires a 

special consideration. 

Microsoft Dynamics CRM supports both read-optimized forms, which are designed to minimize 

page load times to present users with information as efficiently as possible, as well as rich form 

editing, whereby a user can customize out of the box forms or create new forms to accommodate 

specific business scenarios. 

To ensure the best experience with forms in Microsoft Dynamics CRM, end users should have 

systems configured with: 

 RAM: 2 GB or more 

 Operating System: Windows 7 

 Browser: Internet Explorer 9 or later 

 Power Settings: Balanced+ 

In addition, while read-optimized form functionality in Microsoft Dynamics CRM is designed to 

accommodate hardware configurations with slower processors, ensuring a rich experience for 

users who regularly edit Microsoft Dynamics CRM forms requires a more powerful processor. 

Processor requirements for read-optimized forms and for rich form editing is shown in the 

following table: 

 

Recommendation Read-Optimized Forms Rich Form Editing 

Recommended Core Duo, 1.4+ GHz Core i3, 1.6+ GHz 

Minimum Pentium D Core Duo, 1.4+ GHz 

Not Recommended < Pentium/Celeron; Atom Pentium/Celeron; Atom 

 

Note  

http://www.microsoft.com/enable/centers/
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Appendix D: Microsoft Dynamics CRM Online 
performance troubleshooting 
The sections below provide information and guidance on troubleshooting performance issues in 

Microsoft Dynamics CRM Online. As you begin any troubleshooting effort, be sure to gather as 

much information as possible about the details of the performance issues that the user or users 

are experiencing. These things may lead you to identify the source of an issue and will also help 

you provide as much detail as possible to our support team in the event you need additional help 

from Microsoft. 

Troubleshooting considerations 

The following sections call out specific considerations to keep in mind when troubleshooting the 

performance of Microsoft Dynamics CRM Online. 

General considerations 

 What operating system is in use? 

 What is the total amount of memory on the computer? 

 Does the issue repro in the CRM web client, Microsoft Dynamics CRM Online for Outlook, or 

both (it will be important to verify this)? 

 If the issue reproduces in the Microsoft Dynamics CRM Online web client, troubleshoot 

there first as there are other layers of Microsoft Dynamics CRM for Outlook that could 

inhibit your ability to determine the root cause. 

 For issues with Microsoft Dynamics CRM for Outlook, what version of Office is in use? 

 If the issue is occurring in Microsoft Dynamics CRM for Outlook, what Update Rollup is 

currently on the user's computer (this can be verified by getting the version of the 

crmaddin.dll…located in the Microsoft Dynamics CRM\Client\bin directory or by clicking the 

Microsoft Dynamics CRM button in Microsoft Dynamics CRM for Outlook)? 

Considerations about issue magnitude 

 How many users are experiencing the issue? 

 Can the issue be consistently reproduced, or does it happen sporadically? 

 Does the performance issue happen only in certain areas of the Microsoft Dynamics CRM 

Online application?  If so, what area(s)? 

 If the issue is happening sporadically, does it seem to be occurring during a certain time of 

the day, or when a certain process is running? 

Performance considerations 

 What type of internet connection does the user(s) have? 

 Do multiple users experience this issue during the same period of time, or does it appear to 

be a one-off performance issue? 
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 What country is the user experiencing the issue accessing CRM from? 

Network issues 

A first step in identifying the source of a performance issue is to determine whether or not 

network factors (mainly bandwidth or latency) seem to be part of the problem.  Low bandwidth 

and high latency will negatively impact the end-user experience in Microsoft Dynamics CRM 

Online, so be sure to get a baseline reading of WAN performance at the initiation of the 

troubleshooting process. 

The Microsoft Dynamics CRM Product Group has developed a Microsoft Dynamics CRM Online 

Network Performance tool to gather client network configuration data. The tool provides insight 

into the network conditions under which Microsoft Dynamics CRM client is operating.  

 

To run the Microsoft Dynamics CRM Online Network Performance tool 

1. Log in to your Microsoft Dynamics CRM Online organization. 

2. Navigate to the appropriate relative path for your organization: 

https://<orgname>.crm.dynamics.com/tools/diagnostics/diag.aspx 

3. Click the Run button for All Tests. 

Microsoft Dynamics CRM is designed to work best over networks with latency under 150 

milliseconds. 

Optimization tools 

There are also tools available to assist with efforts to optimize the performance of Microsoft 

Dynamics CRM clients. 

Fiddler 

Run a Fiddler trace to determine the duration of each part of the page load process. By reviewing 

the timeline in Fiddler, you should be able to identify which process or processes are taking the 

longest. 

 

To capture data for Microsoft Dynamics CRM Online 

1. In Fiddler, on the Tools menu, click Fiddler Options. 

2. In the Fiddler Options dialog box, on the HTTPS tab, verify that the Capture HTTPS 

CONNECTs check box is selected, select the Decrypt HTTPS traffic check box, and then 

click OK. 

 

For more information on Fiddler, refer to the bog posting Using Fiddler HTTP Debugger for CRM 

Troubleshooting and Performance Tuning. 

Important  

http://blogs.msdn.com/b/crminthefield/archive/2011/05/19/using-fiddler-http-debugger-for-crm-troubleshooting-and-performance-tuning.aspx
http://blogs.msdn.com/b/crminthefield/archive/2011/05/19/using-fiddler-http-debugger-for-crm-troubleshooting-and-performance-tuning.aspx
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SQL tools 

For situations in which more advanced SQL tracing is needed to determine long running queries 

and/or blocking, you will need to engage the Microsoft support team. All previously mentioned 

levels of troubleshooting should be completed prior to taking this step. 

Feedback 
We appreciate hearing from you. To send your feedback, click the link below and type your 

comments in the message body. 

The subject-line information is used to route your feedback. If you remove or modify the 

subject line, we may be unable to process your feedback. 

 

Send feedback 

Conclusion 
 

Note  

http://go.microsoft.com/fwlink/?LinkID=217933

